
Acrobat X Action Create Bookmark Report

Actions are compatible with:
•	 Adobe Acrobat X Pro

•	 Adobe Acrobat X Pro Suite

Process multiple PDF documents and export bookmark reports to PDF reports or reports 
that may be opened in a spreadsheet program.

Acrobat X Pro introduced Actions, a powerful way to standardize processes by automating routine, 
multistep tasks. Since Actions may be extended via JavaScript, there are any number of additional 
operations which can benefit from automation.

The Acrobat X Create Bookmark Report Action processes multiple PDF documents and outputs a 
Summary Document containing:

•	 A unfied report, by document, listing bookmarks in a hiearchical fashion

•	 A Comma Separate Values (CSV) file which may be opened in a spreadsheet program

Acrobat X Action: Create Bookmark Report
Create a report of document bookmarks
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Who benefits from creating 
bookmark reports?
•	 Lawyers who use bookmarks to 

mark important passages in many 
documents

•	 Regulatory personnel who need to 
ensure that bookmarks use 
compliant wording

•	 Anyone who uses bookmarks to 
create an outline of a document 
which needs to be presented 
separately

Extracting the Create Bookmark Report Action
Before intsllaing the Action, you will need to extract it from this document.

1.	 In the Attachments Panel at left, select Create Bookmark Report.sequ

2.	 Right-click and choose Save Attachment to your desktop or other convenient location 

Installing the Create Bookmark Report Action
To install the Create Bookmark Report Action

1.	 Locate the Create Bookmark Report.sequ file on your desktop (or other location)

2.	 Double-click the file and click the Import button.

 
The Edit Actions window will open and display the newly imported Action:
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Using the Create Bookmark Report Action
Before using the Create Bookmark Report Action, locate the files you wish to process. It’s easiest if 
all of the files are in the same folder.

Run the Create Bookmark Report Action
To run the Create Bookmark Report Action, choose File> Action Wizard> Create Bookmark Report 
or open the Tools Pane and choose the Action Wizard to locate the Create Bookmark Report 
Action.

Acrobat will ask you to confirm that you wish to run the Action. Click the Next button.

 
The Select Files Window will open:

 
Click the Add Files or Add Folders button and locate the files you wish to process.  
When finished, click the Next button.

An easy way to access Actions is 
through the Action Wizard Tool Panel

The Select Files window does not allow 
you to reorder documents. If the order 
of processing is important to you, you 
can select and add one document at a 
time. 
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Create Bookmark Report Action Options
Select the options for processing the files you wish to stamp:

1.	 Choose if you wish to create an individual report for each PDF processed. The report will be 
saved in the same location as your original, bookmarked file

2.	 Select this option to include all of the reports in a single file. This will produce a PDF with many 
pages. 

3.	 Set name of the Bookmark Report

4.	 Choose this option to append a CSV report for each PDF processed in the Attachments panel of 
the Summary Document.

5.	 Set the text color for the stamp. Enter a six-digit hexidecimal color 
See “Appendix 1: Hexidecimal Color Chart” on page 4 for sample colors

6.	 Click the OK button to process documents. 











The settings for the Create Bookmark 
Report are “sticky” during the same 
Acrobat session. If you quit Acrobat, the 
settings will be cleared.
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Working with the Summary Document
The Summary Document offers a report of the bookmark processing completed by the Action. The 
first page of a sample report is shown below. Scroll through the rest of the document to view each 
report page.

Files Processed for Bookmark Analysis
(Subsequent Bookmark Summary Actions will add to this file, it must be closed to start a new Summary)

(Bookmark Summaries have been appended to the file, listed in bookmarks)

(CSV files of bookmarks have been attached to this file)

Name: Bookmark Report 
Date: Thu Nov 04, 2010 
Time: 8:42 am

Files Processed: 15 Show Bookmark SummariesShow CSV Attachments

vistaprint_card.pdf - 6 Bookmarks
vmware 6 manual.pdf - 624 Bookmarks
WageWorks.pdf - 1 Bookmarks
welcome.pdf - 0 Bookmarks
What's New in Acrobat7.pdf - 0 Bookmarks
Why Not Buy a PDF Clone.pdf - 0 Bookmarks
WiFi_hi.pdf - 14 Bookmarks
window quote.pdf - 6 Bookmarks
Windows Program  Comments.pdf - 15 Bookmarks
Email Usage  Form .pdf - XFA Form, Skipped
X3 Portfolio - Skipped - Cannot Process, Embedded Files, Skipped
Quick_Start_Guide.pdf - 0 Bookmarks
XMP Briefing 0109.pdf - 0 Bookmarks
xmp_whitepaper.pdf - 16 Bookmarks
Success Story.pdf - 16 Bookmarks

1.	Click the Show CSV Attachments button to view the individual comma separated value (text) 
created from document bookmarks

2.	Click the Show Bookmark Summaries button to open the Bookmarks panel. Use the bookmarks 
to navigate to specific reports. 

3.	Files Processed  
This area is a scrolling text field. Scroll the field to discover which files were processed, how many 
bookmarks were processed per file, and which files were skipped.

Errors when Running Script
The Summary Report will list any errors 
encountered during processing.

•• Error Embedded Files. Skipped 
The Action cannot process certains 
types of PDF Portfolios and PDF 
Packages

•• XFA Form - Skipped 
The Action cannot process XML 
forms created with Adobe LiveCycle 
Designer

Password Protected Files
Encrypted documents which require a 
password to open them will be rejected 
by Acrobat. If you know the password to 
your documents, you can change a 
preference to allow access to Actions. 
Choose Edit>Preferences and choose 
the Actions category. Change the 
Security Method to Password. Acrobat 
will ask you for the Open password each 
time you run an Action.




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Questions and Answers

Can I edit the Create Bookmark Report Action? 
Since the Create Bookmark Report Action writes to specific files and folders, you cannot add 
operations after the report is run. You can edit the source of the files. For example, you could run 
the Action on a specific of files or combine several files together as a source.

What’s the best way to reformat the reports? Can I use Word? 
You can export the PDF Summary report to Word. Choose File>Save As> Microsoft Word. Acrobat 
reliably converts the Summary report.

You can open the CSV files in Word and convert them to a table, but you will need to spend some 
time formatting the information.

The Extract Commented Pages Action 
created by WindJack Solutions, Inc.
Our mission is to make Acrobat and 
PDF easier to use and more accessible 
for everyone. We specialize in all the 
programming activities surrounding 
Acrobat and PDF, including plug-ins, 
JavaScript automation, form scripting, 
and server scripting. We have been at it 
since 1997 and we accomplish our 
mission by mentoring, writing articles, 
teaching classes, creating educational 
materials, lecturing at conferences and 
of course by creating our line of 
software products and services for 
assisting document designers and 
developers to get the most out of PDF.  
We are currently delivering our 
accumulated knowledge of PDF and 
Acrobat development to users through 
our membership website at   
http://www.pdfscripting.com

Exporting from PDF to Word Tip
The Create Bookmark Report Action 
creates an individual report per source 
document. You can export the entire 
Summary Document to Word. You can 
use Search and Replace in Word to 
remove page breaks if you would like a 
continuous report.
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<</Commands [/c <<	/0 [/c <<		/Config [/c <<			/UIPolicy [/i 3]
>>]
		/HandlerName [/a /JavaScript]
		/Params [/c <<			/ScriptCode [/t (//////////////////////////////////////////////\r\n///////////////////////////////////////////////\r\n//\r\n//   Bookmark Summary Action Script\r\n//\r\n//   by Thom Parker, WindJack Solutions, Inc.\r\n//      www.windjack.com, www.pdfscripting.com\r\n//   for Adobe Systems Inc. www.adobe.com\r\n//\r\n//       NOTE: Only for use in an Action Script\r\n//       Requires:  Acrobat 10 or later\r\n//\r\n//   Creates a report PDF of all bookmark names in a PDF\r\n//   Organized to show the hierarchy.  User can choose to \r\n//   place all summaries into a single file or create an \r\n//   individual file for each PDF processed.  \r\n//   User can also choose to create a CSV file report to be\r\n//   attacthed Summary PDF.\r\n// \r\n////\r\n// \r\n//   Version 1.3 - 11/5/2010\r\n\r\nvar bRedo = true;\r\n\r\ntry{global.oBkmkSumDoc.path;}\r\ncatch\(e\)\r\n{// Perform startup action if summary document is invalid\r\n   //Only define dialog if it hasn't been defined before\r\n   if\(typeof\(global.BkMkReportDlg\) == "undefined"\)\r\n   {\r\n      global.BkMkReportDlg =\r\n      {\r\n      \r\n          result:"cancel",\r\n          DoDialog: function\(\){return app.execDialog\(this\);},\r\n          strRptFiles:"SepR",\r\n          strReportPath:"",\r\n          strReportName:"_Bookmarks",\r\n          bBCSV:false,\r\n          GetRadioSel:function\(oRslts,aCtrls\){\r\n            for\(var strRtn=aCtrls[0];aCtrls.length>0;strRtn=aCtrls.pop\(\)\){\r\n              if\(oRslts[strRtn] == true\)\r\n                return strRtn;\r\n            }\r\n            return "";\r\n          },\r\n          initialize: function\(dialog\)\r\n          {\r\n              var dlgInit = \r\n              {\r\n                  "RNme": this.strReportName,\r\n                      "FPth": this.strReportPath,\r\n                      "BCSV": this.bBCSV,\r\n              };\r\n              dlgInit[this.strRptFiles] = true;\r\n              dialog.load\(dlgInit\);\r\n              var bShow = \(this.strRptFiles == "OneR"\);\r\n              dialog.enable\({"FPth":bShow,"Brse":bShow}\);\r\n              dialog.load\({"NLab":bShow?"Report Name:":"Report Postfix:"}\);\r\n          },\r\n          commit: function\(dialog\)\r\n          {\r\n              var oRslt = dialog.store\(\);\r\n              this.strRptFiles = this.GetRadioSel\(oRslt,["SepR","OneR"]\);\r\n              this.strReportPath = oRslt["FPth"];\r\n              this.strReportName = oRslt["RNme"];\r\n              this.bBCSV = oRslt["BCSV"];\r\n          },\r\n          "Brse": app.trustedFunction\(function\(dialog\)\r\n          {\r\n              try{\r\n                app.beginPriv\(\);\r\n                var cRslt = Collab.browseForFolder\(\);\r\n                app.endPriv\(\);\r\n                if\(\(typeof\(cRslt\)!="undefined"\) && \(cRslt != null\)\)\r\n                   dialog.load\({"FPth":cRslt}\);\r\n              }catch\(e\){\r\n                app.alert\("Cannot Browse For Folder"\);\r\n              }\r\n          }\),\r\n          "OneR": function\(dialog\)\r\n          {\r\n              dialog.load\({"RNme":"Bookmark_Report","NLab":"Report Name:"}\);\r\n              dialog.enable\({"FPth":true,"Brse":true}\);\r\n          },\r\n          "SepR": function\(dialog\)\r\n          {\r\n              dialog.load\({"RNme":"_Bookmarks","NLab":"Report Postfix:"}\);\r\n              dialog.enable\({"FPth":false,"Brse":false}\);\r\n          },\r\n          description:\r\n          {\r\n              name: "Create Bookmark Summary Report",\r\n              elements:\r\n              [\r\n                  {\r\n                      type: "view",\r\n                      elements:\r\n                      [\r\n                          {\r\n                              type: "view",\r\n                              char_height: 10,\r\n                              elements:\r\n                              [\r\n                                  {\r\n                                      type: "static_text",\r\n                                      item_id: "stat",\r\n                                      name: "Options for creating the bookmark report.",\r\n                                      char_width: 15,\r\n                                      alignment: "align_fill",\r\n                                      font: "dialog",\r\n                                      bold: true,\r\n                                  },\r\n                                  {\r\n                                      type: "view",\r\n                                      elements:\r\n                                      [\r\n                                          {\r\n                                              type: "radio",\r\n                                              item_id: "SepR",\r\n                                              group_id: "RptF",\r\n                                              name: "Create an individual report file for each PDF processed",\r\n                                              variable_Name: "strRptFiles",\r\n                                          },\r\n                                          {\r\n                                              type: "static_text",\r\n                                              item_id: "sta2",\r\n                                              name: "              \(Saved to Same Folder as Original\)",\r\n                                          },\r\n                                      ]\r\n                                  },\r\n                                  {\r\n                                      type: "view",\r\n                                      align_children: "align_row",\r\n                                      elements:\r\n                                      [\r\n                                          {\r\n                                              type: "radio",\r\n                                              item_id: "OneR",\r\n                                              group_id: "RptF",\r\n                                              name: "Append all reports to a single file",\r\n                                          },\r\n                                          {\r\n                                              type: "button",\r\n                                              item_id: "Brse",\r\n                                              name: "Browse for Folder",\r\n                                          },\r\n                                      ]\r\n                                  },\r\n                                  {\r\n                                      type: "view",\r\n                                      align_children: "align_row",\r\n                                      alignment: "align_fill",\r\n                                      elements:\r\n                                      [\r\n                                          {\r\n                                              type: "static_text",\r\n                                              item_id: "sta1",\r\n                                              name: "Report Location:",\r\n                                          },\r\n                                          {\r\n                                              type: "edit_text",\r\n                                              item_id: "FPth",\r\n                                              variable_Name: "strReportPath",\r\n                                              alignment: "align_fill",\r\n                                          },\r\n                                      ]\r\n                                  },\r\n                                  {\r\n                                      type: "view",\r\n                                      align_children: "align_row",\r\n                                      alignment: "align_fill",\r\n                                      elements:\r\n                                      [\r\n                                          {\r\n                                              type: "static_text",\r\n                                              item_id: "NLab",\r\n                                              name: "Report Postfix:",\r\n                                              alignment: "align_right",\r\n                                              font: "dialog",\r\n                                          },\r\n                                          {\r\n                                              type: "edit_text",\r\n                                              item_id: "RNme",\r\n                                              variable_Name: "strReportName",\r\n                                              alignment: "align_fill",\r\n                                          },\r\n                                      ]\r\n                                  },\r\n                                  {\r\n                                      type: "check_box",\r\n                                      item_id: "BCSV",\r\n                                      name: "Append an CSV Report of the Bookmarks to the Summary Report",\r\n                                  },\r\n                              ]\r\n                          },\r\n                    {\r\n                        type: "view",\r\n                        align_children: "align_row",\r\n                        alignment: "align_fill",\r\n                        elements:\r\n                        [\r\n                          {\r\n                              type: "ok_cancel",\r\n                              cancel_name: "Stop Action",\r\n                          },\r\n                            {\r\n                                type: "gap",\r\n                                item_id: "gap1",\r\n                                width: 40,\r\n                                height: 5,\r\n                            },\r\n                            {\r\n                                type: "static_text",\r\n                                item_id: "sta1",\r\n                                name: "version 1.3  11/5/2010",\r\n                                alignment: "align_right",\r\n                            },\r\n                        ]\r\n                    },\r\n\r\n                      ]\r\n                  },\r\n              ]\r\n          }\r\n      };\r\n   }// End of If for defining dialog\r\n  \r\n  var CreateBkmkSumFields = app.trustedFunction\(function\(oDoc, cName, bAppendExt, bCSV\)\r\n  {\r\n     oDoc.bookmarkRoot.createChild\("Summary Page","this.pageNum=0"\);\r\n     var oFld = oDoc.addField\("Lab1","text",0,[54,423,600,391]\);\r\n     oFld.textSize = 22;\r\n     oFld.textFont = "Helvetica-Bold";\r\n     oFld.textColor = ["G",0];\r\n     oFld.strokeColor = ["T"];\r\n     oFld.borderStyle = "solid";\r\n     oFld.fillColor =  ["T"];\r\n     oFld.value = "Files Processed for Bookmark Analysis";\r\n      \r\n     oFld = oDoc.addField\("Lab2a","text",0, [54,396,600,376]\);\r\n     oFld.textSize = 12;\r\n     oFld.textFont = "Helvetica-Oblique";\r\n     oFld.textColor = ["G",0];\r\n     oFld.strokeColor = ["T"];\r\n     oFld.borderStyle = "solid";\r\n     oFld.fillColor =  ["T"];\r\n     oFld.value = "\(Subsequent Bookmark Summary Actions will add to this file, it must be closed to start a new Summary\)";\r\n\r\n     var nAddH = 0;\r\n     if\(bAppendExt\)\r\n     {\r\n        nAddH += 20;\r\n        oFld = oDoc.addField\("Lab2c","text",0, [54,376,600,356]\);\r\n        oFld.textSize = 12;\r\n        oFld.textFont = "Helvetica-Oblique";\r\n        oFld.textColor = ["G",0];\r\n        oFld.strokeColor = ["T"];\r\n        oFld.borderStyle = "solid";\r\n        oFld.fillColor =  ["T"];\r\n        oFld.value = "\(Bookmark Summaries have been appended to the file, listed in bookmarks\)";\r\n        if\(bCSV\)\r\n        {\r\n           oFld = oDoc.addField\("Lab2d","text",0, [54,376-nAddH,600,356-nAddH]\);\r\n           oFld.textSize = 12;\r\n           oFld.textFont = "Helvetica-Oblique";\r\n           oFld.textColor = ["G",0];\r\n           oFld.strokeColor = ["T"];\r\n           oFld.borderStyle = "solid";\r\n           oFld.fillColor =  ["T"];\r\n           oFld.value = "\(CSV files of bookmarks have been attached to this file\)";\r\n           nAddH += 15;\r\n        }\r\n     }\r\n\r\n     oDoc.addAnnot\({type:"Line", page:0, points:[[36,373-nAddH],[613,373-nAddH]], width:2, style:"S",\r\n                    strokeColor:color.black, arrowEnd:"None",arrowBegin:"None"}\);\r\n\r\n     oFld = oDoc.addField\("Lab2","text",0, [60,373-nAddH,384,323-nAddH]\);\r\n     oFld.multiline = true;\r\n     oFld.textSize = 12;\r\n     oFld.textFont = "Helvetica";\r\n     oFld.textColor = ["G",0];\r\n     oFld.strokeColor = ["T"];\r\n     oFld.borderStyle = "solid";\r\n     oFld.fillColor =  ["T"];\r\n     oFld.value = "Name: " + cName + "\\nDate: " + util.printd\("ddd mmm dd, yyyy",new Date\(\)\)\r\n                  + "\\nTime: " + util.printd\("hh:mm tt",new Date\(\)\);\r\n\r\n     app.beginPriv\(\);\r\n     oDoc.flattenPages\(\);\r\n     app.endPriv\(\);\r\n\r\n     var oFld = oDoc.addField\("NumFiles","text",0,[60,316-nAddH,300,296-nAddH]\);\r\n     oFld.readonly = true;\r\n     oFld.textSize = 14;\r\n     oFld.textFont = "Helvetica-Bold";\r\n     oFld.textColor = ["G",0];\r\n     oFld.strokeColor = ["T"];\r\n     oFld.borderStyle = "solid";\r\n     oFld.fillColor =  ["T"];\r\n     oFld.value = "Files Processed: 0";\r\n\r\n     if\(bAppendExt\)\r\n     {\r\n        var oFld = oDoc.addField\("ShowAtt","button",0,[430,318-nAddH ,600 ,294-nAddH]\);\r\n        oFld.textSize = 12;\r\n        oFld.textFont = "Helvetica-Bold";\r\n        oFld.textColor = ["G",0];\r\n        oFld.strokeColor = ["G",0];\r\n        oFld.borderStyle = "solid";\r\n        oFld.fillColor =  ["G",2/3];\r\n        oFld.buttonSetCaption\("Show Bookmark Summaries"\);\r\n        oFld.setAction\("MouseUp","this.viewState = {overViewMode:3}"\);\r\n\r\n        if\(bCSV\)\r\n        {\r\n           var oFld = oDoc.addField\("ShowAtt2","button",0,[275,318-nAddH ,425 ,294-nAddH]\);\r\n           oFld.textSize = 12;\r\n           oFld.textFont = "Helvetica-Bold";\r\n           oFld.textColor = ["G",0];\r\n           oFld.strokeColor = ["G",0];\r\n           oFld.borderStyle = "solid";\r\n           oFld.fillColor =  ["G",2/3];\r\n           oFld.buttonSetCaption\("Show CSV Attachments"\);\r\n           oFld.setAction\("MouseUp","this.viewState = {overViewMode:7}"\);\r\n        }\r\n     }\r\n\r\n     var oFld = oDoc.addField\("FilesProcessed","listbox",0,[60,290-nAddH,600,36]\);\r\n     oFld.readonly = false;\r\n     oFld.commitOnSelChange = true;\r\n     oFld.textSize = 12;\r\n     oFld.textFont = "Helvetica";\r\n     oFld.textColor = ["G",0];\r\n     oFld.strokeColor = ["G",0];\r\n     oFld.borderStyle = "solid";\r\n     oFld.fillColor =  ["T"];\r\n     oFld.setAction\("Format","this.dirty = false"\);\r\n\r\n  }\);\r\n\r\n \r\n   var DoSetupBkMkSum = app.trustedFunction\(function\(oDoc\)\r\n   {\r\n     var bRedo = true;\r\n     // Setup initial document parameters\r\n     global.BkMkReportDlg.strReportPath = oDoc.path.replace\(/\\/[^\\/]+$/,"/"\);\r\n     global.bSkipSumSave = false;\r\n\r\n     app.beginPriv\(\);\r\n     while\(bRedo\)\r\n     {\r\n        global.oBkmkSumDoc = null;\r\n        if\("ok" == app.execDialog\(global.BkMkReportDlg\)\)\r\n        {\r\n            global.nDocsProcessed = 0;\r\n\r\n            // Create Summary Doc\r\n        		global.oBkmkSumDoc = app.newDoc\(649,459\);\r\n\r\n            var bOneDoc = global.BkMkReportDlg.strRptFiles == "OneR";\r\n            // Add Fields to Doc and set data\r\n            CreateBkmkSumFields\(global.oBkmkSumDoc, global.BkMkReportDlg.strReportName, bOneDoc, global.BkMkReportDlg.bBCSV\);\r\n            \r\n\r\n            // Setup Path to extraction file\r\n            cSumPath = global.BkMkReportDlg.strReportPath.replace\(/\([^/]\)$/, "$1/"\) \r\n                       + \(bOneDoc?"":"BookmarkSummary"\) + global.BkMkReportDlg.strReportName + ".pdf";\r\n            try{\r\n               global.oBkmkSumDoc.saveAs\(cSumPath\);\r\n               bRedo = false;\r\n            }catch\(e\){\r\n               var cRslt = app.alert\("Bookmark Summary file could not be saved to:\\n" + cSumPath\r\n                                + "\\n\\nDo you want to reenter? \(Pressing No will"\r\n                                + " continue the Action with an unnamed Summary file\)"\r\n                                + " pressing Cancel will Stop the Action",1,3\);\r\n               switch\(cRslt\)\r\n               {\r\n                  case 2: // Abort\r\n                    event.rc = false;\r\n                    bRedo = false;\r\n                    global.oBkmkSumDoc.closeDoc\(true\);\r\n                    break;\r\n                  case 3:  // Continue\r\n                    global.bSkipSumSave = true;\r\n                    bRedo = false;\r\n                    break;\r\n                  case 4:  // Reenter\r\n                    bRedo = true;\r\n                    global.oBkmkSumDoc.closeDoc\(true\);\r\n                    break;\r\n               }\r\n            }\r\n        }\r\n        else\r\n        { // Abort Action\r\n            event.rc = false;\r\n            bRedo = false;\r\n        }\r\n     }// Loop back for redo\r\n     app.endPriv\(\);\r\n   }\);\r\n\r\n   DoSetupBkMkSum\(event.target\);\r\n\r\n  console.println\("Setup Done"\);\r\n} \r\n\r\nvar g_nNumBkmks = 0;\r\nvar ReportbookmarksCSV = app.trustedFunction\(function\(oBkmks, oRpt, aCSVData, nLevel\)\r\n{\r\n   var nMaxLevel = nLevel+1;\r\n   app.beginPriv\(\);\r\n   oRpt.indent\(\);\r\n   var nIndent = oRpt.absIndent;\r\n//   console.println\("OnStart: Level=" + nLevel + "  Indent=" + nIndent\);\r\n   if\(oBkmks && oBkmks.children\)\r\n   {\r\n     for\(var i=0;i<oBkmks.children.length;i++\)\r\n     {\r\n        // Trim\r\n        var cCleanName = oBkmks.children[i].name.replace\(/\(^\\s+\)|\(\\s+$\)/g,""\); \r\n        var cCsvName = cCleanName;\r\n\r\n        // Quote string if it contains quotes or commas\r\n        if\(/[\\"\\,]/.test\(cCleanName\)\)\r\n           cCsvName = '"' + cCleanName.replace\(/\\"/g,'""'\) + '"';\r\n\r\n        var aLine = [];\r\n        aLine[nLevel] = cCsvName;\r\n        aCSVData.push\(aLine\);\r\n\r\n        g_nNumBkmks++;\r\n        oRpt.absIndent = nIndent;\r\n        var rctOut = oRpt.writeText\(cCleanName\);\r\n        \r\n        if\( \(Math.floor\(app.viewerVersion\)==9\) && \(rctOut[1] < 36\)\)\r\n        {\r\n          // Save and restore indent\r\n           oRpt.breakPage\(\);\r\n     console.println\("AFterBreak: " + oRpt.absIndent\);\r\n\r\n           oRpt.absIndent = nIndent;\r\n        }\r\n\r\n        if\(oBkmks.children[i].children\)\r\n        {\r\n          var nRtnLvl = ReportbookmarksCSV\(oBkmks.children[i], oRpt, aCSVData, nLevel+1\);\r\n          if\(nRtnLvl > nMaxLevel\) nMaxLevel = nRtnLvl;\r\n        }\r\n     }\r\n   }\r\n   oRpt.outdent\(\);\r\n   app.endPriv\(\);\r\n   return nMaxLevel;\r\n}\);\r\n\r\nvar ReportbookmarksXML = app.trustedFunction\(function\(oBkmks, oRpt, oXRpt\)\r\n{\r\n   app.beginPriv\(\);\r\n   oRpt.indent\(\);\r\n   if\(oBkmks && oBkmks.children\)\r\n   {\r\n     for\(var i=0;i<oBkmks.children.length;i++\)\r\n     {\r\n        oXRpt.child[i] = "";\r\n        oXRpt.child[i].@index = i;\r\n        oXRpt.child[i].@name = oBkmks.children[i].name;\r\n        g_nNumBkmks++;\r\n        var rctOut = oRpt.writeText\(oBkmks.children[i].name\);\r\n        if\(\(app.viewerVersion >=9\) && \(rctOut[1] < 52\)\)\r\n           oRpt.breakPage\(\);\r\n\r\n        if\(oBkmks.children[i].children\)\r\n          ReportbookmarksXML\(oBkmks.children[i], oRpt,oXRpt.child[i]\);\r\n     }\r\n   }\r\n   oRpt.outdent\(\);\r\n   app.endPriv\(\);\r\n}\);\r\n\r\n\r\n\r\nif\(event.rc != false\)\r\n{\r\n  // Increment number of docs processed  \r\n  global.nDocsProcessed++;\r\n  global.oBkmkSumDoc.getField\("NumFiles"\).value = "Files Processed: " + global.nDocsProcessed;\r\n  var cBkmkSumPath = "Not Set";\r\n  var cErrMsg = "";\r\n  \r\n   console.println\("Working Doc: " + event.target.documentFileName\);\r\n  var oDoc = event.target;\r\n\r\n  if\(typeof\(oDoc.xfa\)!="undefined"\)\r\n  {\r\n    cErrMsg = "XFA Form, Skipped";\r\n  }\r\n  else if\(global.oBkmkSumDoc == oDoc\)\r\n  {\r\n    cErrMsg = "Cannot Process Summary Doc, Skipped";\r\n  }\r\n  else if\(oDoc.path[0] == "|"\)\r\n  {\r\n    cErrMsg = "Cannot Process Embedded Files, Skipped";\r\n  }\r\n  else\r\n  {// Create Report\r\n     var rptBkmks = new Report\(\);\r\n\r\n     //Add Report Header\r\n     rptBkmks.size = 2;\r\n     rptBkmks.writeText\("Bookmark Summary for: " + oDoc.documentFileName\);\r\n     rptBkmks.size = 1;\r\n     rptBkmks.writeText\(" "\);\r\n     rptBkmks.writeText\("Location: " + oDoc.path\);\r\n     rptBkmks.writeText\("Processed: " + util.printd\("ddd mmm d, yyyy - hh:MM tt",new Date\(\)\)\);\r\n     rptBkmks.writeText\(" "\);\r\n     if\(global.BkMkReportDlg.bBCSV && \(global.BkMkReportDlg.strRptFiles != "OneR"\)\)\r\n     {\r\n       rptBkmks.writeText\("CSV\(Excel\) file of bookmarks attached:  " + oDoc.documentFileName.replace\(/\\.pdf/,"_BkmkReport.csv"\)\);\r\n       rptBkmks.writeText\(" "\);\r\n     }\r\n     rptBkmks.divide\(\);\r\n     rptBkmks.writeText\(" "\);\r\n\r\n    // Walk Bookmarks and set names\r\n    g_nNumBkmks = 0;\r\n/*\r\n    // Setup XML for collecting bookmark names\r\n    var oXRpt = <BkmkReport></BkmkReport>;\r\n    oXRpt.@src = oDoc.path;\r\n    oXRpt.@date = util.printd\("dd-mm-yyyy",new Date\(\)\);\r\n    oXRpt.@time = util.printd\("HH:MM:ss",new Date\(\)\);\r\n*/\r\n\r\n    var aCSVData = [];\r\n    var nMaxLevel = ReportbookmarksCSV\(oDoc.bookmarkRoot, rptBkmks, aCSVData, 0\);\r\n\r\n  console.println\("Found: " + g_nNumBkmks\);\r\n    //Open Report\r\n    // if append then open as Temp\r\n    if\(global.BkMkReportDlg.strRptFiles == "OneR"\)\r\n    {\r\n       var cTmpPth = app.getPath\("user","temp"\).replace\(/\([^/]\)$/, "$1/TempBk.pdf"\);\r\n       rptBkmks.save\(cTmpPth\);\r\n    // and extract pages into summary doc\r\n       var nCurPage = global.oBkmkSumDoc.numPages;\r\n       global.oBkmkSumDoc.insertPages\(global.oBkmkSumDoc.numPages-1,cTmpPth\);\r\n       global.oBkmkSumDoc.bookmarkRoot.createChild\(oDoc.documentFileName,\r\n                                                   "this.pageNum=" + nCurPage,\r\n                                                   global.oBkmkSumDoc.bookmarkRoot.children.length\);\r\n    }\r\n    else\r\n    {// else open to file name with postfix.\r\n       cBkmkSumPath = oDoc.path.replace\(/\\.pdf/,global.BkMkReportDlg.strReportName + ".pdf"\);\r\n       rptBkmks.save\(cBkmkSumPath\);\r\n    }\r\n\r\n    if\(global.BkMkReportDlg.bBCSV && \(g_nNumBkmks > 0\)\)\r\n    {\r\n      var aHdr = [];\r\n      for\(var i=1;i<=nMaxLevel;i++\)\r\n         aHdr.push\("Level"+i\);\r\n      aCSVData.unshift\(aHdr\);\r\n      for\(var i=0;i<aCSVData.length;i++\)\r\n      {\r\n         if\(aCSVData[i].length < nMaxLevel\)\r\n            aCSVData[i][nMaxLevel-1] = "";\r\n      }\r\n\r\n			if\(global.BkMkReportDlg.strRptFiles == "OneR"\)\r\n      {// Save in summary file\r\n			   global.oBkmkSumDoc.createDataObject\({ \r\n					   cName: oDoc.documentFileName.replace\(/\\.pdf/,global.BkMkReportDlg.strReportName + ".csv"\), \r\n					   cValue: aCSVData.join\("\\r"\) \r\n    			}\);\r\n      }\r\n      else\r\n      {  // Save in Report file\r\n         var oSumDoc = app.openDoc\({cPath:cBkmkSumPath,bHidden:true}\);\r\n			   oSumDoc.createDataObject\({ \r\n					   cName: oDoc.documentFileName.replace\(/\\.pdf/,global.BkMkReportDlg.strReportName + ".csv"\), \r\n					   cValue: aCSVData.join\("\\r"\) \r\n    			}\);\r\n         oSumDoc.saveAs\(cBkmkSumPath\);\r\n         oSumDoc.closeDoc\(true\);\r\n      }\r\n    }\r\n\r\n  }\r\n\r\n  // Place File Name in Summary File;\r\n  var cItemSumText = "#" + global.nDocsProcessed + ": " + event.target.documentFileName;\r\n\r\n  if\(cErrMsg.length\)\r\n     cItemSumText += " - " + cErrMsg;\r\n  else\r\n  {\r\n    cItemSumText += " - " + g_nNumBkmks + " Bookmarks";\r\n    if\(global.BkMkReportDlg.bBCSV && \(g_nNumBkmks == 0\)\)\r\n      cItemSumText += "\(No CSV\)";\r\n    if\(global.BkMkReportDlg.strRptFiles != "OneR"\)\r\n      cItemSumText += " to " + cBkmkSumPath;\r\n  }\r\n\r\nconsole.println\("msg:" + cItemSumText\);\r\n\r\n  var oFld = global.oBkmkSumDoc.getField\("FilesProcessed"\);\r\n  oFld.insertItemAt\(cItemSumText,oFld.numItems,-1\);\r\n  if\(!global.bSkipSumSave\)\r\n  {\r\n//     console.println\("Save Path: " + global.oExtrSumDoc.path\);\r\n     global.oBkmkSumDoc.saveAs\(global.oBkmkSumDoc.path\);\r\n  }\r\n  global.oBkmkSumDoc.bringToFront\(\);\r\n\r\n\r\n}\r\n\r\n\r\n)]
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